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1. Паспорт программы

Профессиональная среда: креативная
Наименование профессионального направления: Графический дизайн 

Автор программы: Азизова Л.Н., к.п.н., преподаватель
Контакты автора: р. Дагестан, г. Махачкала, liliya.azizova@yandex.ru, 8928-876-28-22
Площадка: ГБПОУ РД «Технический колледж имени Р.Н. Ашуралиева», Республика Дагестан, г. Махачкала, пр. Гамидова, Студенческий переулок, 3, корпус 2, Центр опережающей профессиональной подготовки
	Уровень сложности
	Формат проведения
	Время проведения
	Возрастная категория
	Доступность для участников с ОВЗ

	




базовый
	




очная
	




90 минут
	




6-7/8-9/
10-11 класс
до 15 чел.
	Допустимая нозологическая группа/группы:
· Общие заболевания (нарушение дыхательной системы, пищеварительной, эндокринной систем, сердечно-сосудистой системы и т.д.)
· Нарушение слуха: глухие,
· Нарушение слуха: слабослышащие,
· Нарушение опорно-двигательного аппарата (НОДА)
· Тяжёлые нарушение речи
Специальные условия для детей с нарушениями слуха
и речи:
· Обеспечение оборудованием для воспроизведения и усиления звука для качественной передачи на слуховые аппараты  участников
· Обеспечить освещенность лица говорящего и фона за ним, проецирование медиафайлов на большие экраны.
· Обеспечение подробных индивидуальных инструкций и вспомогательной информации в письменном виде
· При необходимости – наличие сурдопереводчика.
Специальные условия для детей с нарушениями
опорно-двигательного аппарата (преимущественно -
нижние конечности)
· В организации должны быть созданы надлежащие материально-технические условия, обеспечивающие возможность для беспрепятственного доступа детей в здания и помещения организации и их пребывания и участия в мероприятии (включая пандусы, специальные лифты, санузлы, специально оборудованные учебные места с регулируемыми партами и т.д.).
· На каждом мероприятии после 20 минут занятий рекомендовано проводить 5-минутную физкульт-паузу с включением лечебно-коррекционных мероприятий
· Обязательным условием является соблюдение индивидуального ортопедического режима, для каждого обучающегося с двигательной патологией
Возможно одновременное участие детей с инвалидностью
и ОВЗ и детей без инвалидности




[bookmark: _Toc115110839]2. Содержание программы

Введение
Графический дизайн — это профессиональная сфера человеческой деятельности, которая находится на перекрестке изобразительного искусства, общения, психологии и других экспертных областей. Графические дизайнеры создают способы и средства коммуникации с помощью графических (визуальных) элементов:изображений различного стиля и сложности, фотографий, текста и шрифтов, пиктограмм, форм и размеров, цветов и оттенков, линий и кривых, макетов страниц и т. д. 
Графический дизайнер делает графику для передачисообщения, тем самым делая ее функциональной. Графический дизайн можно охарактеризовать кактворческую область, где таланты применяются не в чистом искусстве, а как в искусстве созданное с коммуникационной целью. 
Существует несколько временных версий того, когда зародился графический дизайн. По версии Philip Megg, автора книги «История графического дизайна», всё началось с пещер Ласко, когда древний человек изобразил на камне сцену охоты. 
По другой версии, именно книгопечатание положило начало графическому дизайну. Третья версия, — самая популярная, связана с появлением профессии графического дизайнера. В начале 20 века, в момент зарождения промышленной революции созрела потребность в услугах дизайнера. Именно в годы рождения Coca-Cola в США возникла потребность в графическом рекламе, дизайне и упаковке. 
Сегодня графический дизайн — это широкая область применения художественных талантов в различных формах. Например, графический дизайн включает в себя  создание:
· иллюстраций;
· идентичности бренда (логотип и айдентика);
· пиктограмм и иконок;
· типографики;
· пользовательских интерфейсов и их элементов;
· рекламных объявлений;
· графических объектов для анимированных видеороликов и мультфильмов;
· больших печатных изображений, такие как плакаты и рекламные щиты;
· обработку графики;
· инфографику;
· разработку упаковки и т.д.
Графический дизайнер - человек, который занимается созданием визуальных образов на заказ. От него требуется: разрабатывать логотип и узнаваемую символику, фирменный шрифт и цветовую гамму (и т.д.), которые бы соответствовали концепции и духу компании-заказчика. В общем все, что позволяет узнать бренд с первого взгляда. Деятельность эта сочетает творчество и холодную прагматику.
Без цепляющего дизайна в наше время невозможно выдержать конкуренцию на рынке, а хороший графический проект может обеспечить быструю раскрутку молодого бизнеса через качественный, запоминающийся, создающий ощущение надежности образ. Совершенно любая организация нуждается в отличительных чертах и в регулярном обновлении, или переосмыслении своего образа в соответствии с изменениями тенденций и эстетических кодов в обществе. По этим причинам профессия графического дизайнера чрезвычайно необходима и востребована сегодня. 
Для работы графическим дизайнером необходимо обладать: 
· Базовыми художественными навыками. 
· Знанием теории и истории графического дизайна. 
· Азами работы с графическими редакторами (например: Adobe Illustrator, Adobe InDesign, Adobe Photoshop). Впрочем, чем лучше они освоены, тем лучше для профессионального роста.
Сегодня вся работа перенесена на электронные носители, поэтому ограничивать себя карандашом и листом - опасная идея. Сложность заключается только в том, что для успешной работы требуется комбинация из художественных навыков, владения графическими редакторами и наличия фантазии. Но все можно развить, главное - наличие интереса!

Постановка задачи
В рамках данной пробы, предлагается разработать паттерн. Паттерн является важным элементом фирменного стиля компании и может использоваться как фоновое изображение или как главный декоративный элемент, привлекающий к себе внимание. Дизайн фирменного стиля — это визуальная «персона» компании, которая помогает достигнуть основных целей в бизнесе (за счет брендинга и товарных знаков). Почему важно использовать паттерн в фирменном стиле: 
· Использование паттерна добавляет дороговизну бренду. 
· Оригинальный узор формирует уникальность и повышает узнаваемость компании.
· Паттерн помогает донести до потребителя ценности и суть деятельности бренда. 
Для создания паттерна необходимо выполнить ряд действий:
1. Включить персональный компьютер.
2. Запустить программное обеспечение «Adobe Illustrator»
3. Четко выполнять действия, указанные в распечатанной инструкции

Выполнение задания

Инструкция для 6-9 классов Рисование тюльпана 
Шаг 1.  
Инструментом Ellipse/Эллип (L) нарисуйте маленький круг. Инструментом Direct Selection/Прямое выделение (A) потяните верхнюю точку вверх. Вы можете оставить ее округлой, а можете заострить при помощи инструмента Convert Anchor 
Point/Преобразовать опорную точку . Теперь инструментом Selection/Выделение (V) сплющите немного фигуру. Это будет базовый лепесток тюльпана. 
[image: ] 
[bookmark: _Toc115110840]Шаг 2 
Копируйте (Control-C) и вставьте (Control-V) дважды лепесток. Инструментом  Rotate/Поворот поверните копии лепестка на 20 и на -20 соответственно. Выделите все три лепестка и нажмите Unite/Объединить в палитре Pathfinder/Обработка контура. Инструментом Delete Anchor Point/Удалить опорную точку (-) удалите нижние точки, находящиеся не по центру тюльпана. 
[image: ] 
[bookmark: _Toc115110841]Шаг 3 
Для стебля и листьев, необходимо следовать процедуре, начиная с Шага 1: Нарисуйте круг, потяните левую точку влево и оставьте так или заострите угол. Стебель нарисуйте при помощи инструмента Rectangle/Прямоугольник (M). Поместите его под головку тюльпана в палитре Layers/Слои. Скопируйте и вставьте листья Сгруппируйте (Control-G) компоненты вашего тюльпана. 
[image: ] 
 
[bookmark: _Toc115110842]Рисование маргаритки 
Шаг 1 Инструментом Polygon/Многоугольник нарисуйте фигуру с восемью сторонами. Выделите фигуру и в меню выберите Effect > Distort & Transform > Pucker & Bloat/ 
Эффект>Исказить и Трансформировать>Втягивание и раздувание. Настройте как показано ниже на рисунке.  
[image: ] 
[bookmark: _Toc115110843]Шаг 2 
Выберите Expand/Разобрать в меню Object/Объект. Инструментом Ellipse/Эллипс нарисуйте кружочек-сердцевину маргаритки. 
[image: ] 
[bookmark: _Toc115110844]Шаг 3 
Для создания стебля нарисуйте длинный и тонкий прямоугольник. В меню выберите Effect > Warp > Flag/Эффект>Деформация>Флаг. Настройте как показано ниже, затем нажмите Expand/Разобрать в меню Object/Объект. Поместите стебель под цветок в палитре Layers/Слои. 
[image: ] 
 
Дополнительные цветы для создания паттерна 
[bookmark: _Toc115110845]Шаг 1 
Рисуем ромашку. Делаем то же, что и при создании маргаритки, только на этот раз многоугольник будет иметь 20 сторон. Еще раз, применяем эффект Pucker & Bloat/Втягивание и раздувание. Настраиваем как показано ниже. 
Затем Expand/Разбираем фигуру и рисуем для нее сердцевинку. 
[image: ] 
[bookmark: _Toc115110846]Шаг 2 
Для следующего цветка мы создадим кисть. Нарисуйте маленький круг инструментом Ellipse/Эллипс. Выделите его и в палитре Brushes/Кисти выберите New Brush/Новая кисть > Scatter Brush/Дискретная кисть. Оставьте параметры как показано ниже. 
[image: ] 
[bookmark: _Toc115110847]Шаг 3 
Нарисуйте круг и укажите ему обводку новой кистью. (Выделите круг, затем выделите кисть в панели кистей). Expand/Разберите цветок и удалите лишние элементы, если это необходимо. 
[image: ] 
[bookmark: _Toc115110848]Шаг 4 
Еще один легкий цветок для общей композиции. Нарисуйте круг и примените к нему эффект Pucker & Bloat/Втягивание и раздувание. Настройте как показано ниже. 
[image: ] 
[bookmark: _Toc115110849]Шаг 5 
Последний цветок из многоугольника с шестью сторонами и уже знакомого эффекта, настроенного как показано ниже. 
[image: ] 
[bookmark: _Toc115110850]Шаг 6 
Копируйте 	и 	вставьте 	цветок, 	укажите 	копии 	контрастный 	цвет 
(розовый). Scale/Масштабируйте копию цветка и разместите поверх оригинала. 
Нарисуйте сердцевину и сгруппируйте все элементы цветка. 
[image: ] 
Собираем паттерн 
[bookmark: _Toc115110851]Шаг 1 
Соберите элементы узора вместе. (Дублируйте элементы, меняйте цвета, размеры и угол наклона, чтобы паттерн получился красочным). Добавьте в пустые места небольшие цветочки и кружочки. 
[image: ] 
[bookmark: _Toc115110852]Шаг 2 
Выделите все элементы вашего паттерна и нажмите кнопку Make New/Создать новый в палитре Pattern Options/Настройки узора. Заполните пустые места, если они есть. Нажмите Done когда вы будете удовлетворены тем, что видите. Вы увидите, что узор сохранен в палитре Swatches/Образцы. Вы можете вернуться к его редактированию, когда угодно, кликнув по нему дважды. 
[image: ] 
 
[bookmark: _Toc115110853]Шаг 3 
Вы можете при помощи инструмента Zoom/Масштаб (Z)  посмотреть как ваш паттерн смотрится «издалека». Можете попробовать другие значения параметра Tile Type/Тип плитка чтобы сделать паттерн интереснее. 
[image: ] 
 
P.S. Основываясь на данную инструкцию попробуйте создать собственный паттерн.  
 
 	 Инструкция для 10-11 классов 
1. Откройте Adobe Illustrator и создайте документ размером 600 х 600 пикселей. 
[image: ] 
2. Выберите инструмент Прямоугольник/Rectangle (M) и удерживая Shift нарисуйте квадрат по размеру холста. Укажите ему заливку голубого небесного цвета и отсутствие обводки.  
[image: ] 
3. Рисуем облака на нашем небе. Выберите инструмент Эллипс/Ellipse (L), укажите в качестве основного цвета - белый и из кругов и овалов составьте облака. Например, как на картинке ниже. 
[image: ] 
4. Выделите овалы составляющие одно облако и в палитре Обработка контуров/Pathfinder нажмите на кнопочку Объединить/Unite. Повторите процедуру со всеми облаками. 
[image: ] 
5. Инструментом Эллипс/Ellipse нарисуйте овал красного цвета. В палитре Прозрачность/Transparency укажите ему Непрозрачность/Opacity в 70%. 
[image: ] 
6. Выберите инструмент Перо/Pen Tool (P) и нарисуйте белые блики в левой верхней и нижней правой частях шара. Должно получиться примерно как на картинке ниже. Укажите бликам непрозрачность в 60%. 
[image: ] 
7. Инструментом Эллипс/Ellipse нарисуйте на шаре белый овал как показано ниже. 
[image: ] 
8. Нарисуйте еще один белый овал поменьше внутри большого овала. 
[image: ] 
9. Укажите большому овалу непрозрачность в 0%. 
[image: ] 
10. Теперь дважды кликните по инструменту Переход/Blend Tool. Укажите ему параметры как указано на картинке ниже. 
[image: ] 
11. Выделите оба белых овала и нажмите Ctrl+Alt+B (Com+Alt+B для Imac) . Таким образом вы создаете переход в 25 указанных выше шагов между маленьким овалом и большим прозрачным. 
[image: ] 
12. Инструментом Выделение/Selection выделите весь объект, который образовался в следствии только что произведенных действий, и укажите ему непрозрачность в 30%. 
[image: ] 
13. Теперь нам нужно настроить объект так, чтобы была осветлена именно та часть шара, которую мы хотим сделать светлее. Инструментом Прямое Выделение/Direct Selection Tool выделяйте поочередно или вместе самый маленький и самый большой овалы, чтобы отредактировать их положение, размер и угол наклона. Используйте инструмент Свободное Трансформирование/Free Transform Tool. Вот что должно получиться в итоге: 
[image: ] 
14. Под шариком нарисуйте небольшой овал того же цвета и степени прозрачности что и сам шарик. 
[image: ] 
15. Инструментом Перо/Pen Tool нарисуйте поверх шарика фигуру как показано на картинке ниже. Выделите овал и фигуру и в палитре Обработка контуров/Pathfinder нажмите на кнопку Минус Верхний/Minus Front. 
[image: ] 
16. Поместите хвостик так, чтобы он соприкасался с шариком лишь в одной точке. 
[image: ] 
17. Рисуем ниточку. Инструментом Отрезок линии/Line Segment Tool нарисуйте прямую линию от шарика вниз. 
[image: ] 
18. Не снимая выделение с линии, выберите в меню Effect > Distort & Transform > Roughen / Эффект > Исказить и трансформировать > Огрубление. Укажите размер (size) в 4% и детали (Detail) в 2. Выберите вариант Smooth (скругление). Ниточка начнет виться. Пометите ниточку на задний план.  
[image: ] 
19. Рисуем зеленый шарик. Инструментом Эллипс/Ellipse Tool нарисуйте зеленый круг. Дублируйте его несколько раз и расположите как показано на картинке ниже. Выделите все круги и объедините их через палитру Обработка контуров/Pathfinder. 
[image: ] 
20. Получившейся фигуре укажите непрозрачность в 70%. Нарисуйте блики по той же схеме что и для красного шара. 
[image: ] 
21. Дублируйте осветляющий объект на красном шаре (тот, что мы делали при помощи Перехода). Расположите его на зеленом шаре и отредактируйте малый и большой овалы так, как вам удобно. Дублируйте объект еще три раза, чтобы осветлить участки на всем зеленом шарике. Дублируйте веревочку и нитку от красного шара и поместите их к зеленому. Укажите хвостику цвет зеленого шара. 
[image: ] 
22. Из синего круга сделайте еще один шар по той же схеме. 
[image: ] 
23. Выделите все элементы, составляющие красный шар и нажмите Ctrl + G. Таким образом вы сгруппировали фигуры, составляющие шар. Сделайте то же с остальными шарами, чтобы ими было удобно управлять при составлении паттерна. Выделите все шары и облака и в меню выберите Object > Pattern > Make / Объект > Узор > Создать. 
[image: ] 
24. Расположите элементы так, как вам нравится. Дублируйте их, экспериментируйте с масштабом углом наклона. Ориентируйтесь на синюю рамку, которая ограничивает ваш паттерн. Должно получиться примерно как на картинке ниже. Когда закончите с расположением элементов просто кликните дважды в любом пустом месте. 
[image: ] 
25. Паттерн появился в палитре Swatches/Образцы. Мы можем применить его к любому объекту.  
[image: ] 
 
P.S. Самостоятельно добавьте новые элементы паттерну. 


Рекомендации для наставника по организации процесса выполнения задания
Рекомендации наставнику:
· Принять площадку проведения пробы
· Распечатать предлагаемую инструкцию
· Ознакомить с техникой безопасности на рабочем месте
· Выяснить уровень готовности каждого (знание ПК, знание программного обеспечения)
· Объяснить задание (поставить цель)
· Раздать печатные инструкции
· Продемонстрировать на своем рабочем месте ход выполнения задания
· Проконтролировать процесс выполнения и отвечать на вопросы
Контроль, оценка и рефлексия
Критерии успешного выполнения задания:
· Успешное завершение алгоритма Инструкции (наличие паттерна)
· Качество исполнения заданных технических параметров
· Творческая составляющая 
Рекомендации для наставника по контролю результата, процедуре оценки:
· проверить правильность выполнения всех необходимых этапов выполнения задания и соотнести готовый результат с шаблоном.


[bookmark: _Toc115110854]3. Инфраструктурный лист

	[bookmark: _Hlk13065239]Наименование
	Рекомендуемые технические характеристики с необходимыми примечаниями
	Количество
 
	На 1 чел.

	Компьютер в сборе с монитором, мышкой и клавиатурой	
	intel Core i5-8400,  / 8 Гб / 1 Тб / Nvidia GTX 1060 3gb / DVDRW / Win10 pro
	15
	1

	Программное обеспечение
	Adobe Illustrator
	15
	1

	Стол компьютерный
	 На усмотрение организатора
	15
	1

	Стул/офисное кресло
	На усмотрение организатора
	15
	1



[bookmark: _Toc115110855]4. Приложение и дополнения

	Ссылка
	Комментарий

	https://www.behance.net/
	медиа-платформа для дизайнеров и иллюстраторов всего мира 

	https://dribbble.com/
	онлайн-сервис, объединяющий графических дизайнеров, веб-дизайнеров, иллюстраторов и 3D-визуализаторов

	https://www.freepik.com/
	онлайн сервис с множеством бесплатных ресурсов по графическому дизайну

	 https://www.canva.com/
	онлайн-сервис для создания элементов графического дизайн
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